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Introducing Flow

Y
JOLLY

Label Flow is premier software for ID label design, production and data management.

This guide provides basic understanding of product components and how to get started.
This guide is a supplement to the Help Menu provided within the product. The built-in
Help Menu provides comprehensive configuration details for each dialog.

o e g« i i - I i P it
|/ b - oy

| Lishad Grousp: | Shappeng Lakal

Frtug

Bl Roerd

Fired Bgsgard

= Fivw plnbiind by Jeity Toehasiapied

P—

Rapgoard Cander

The Quick Start Option

Label Flow is preconfigured with Workstation Profiles that contain several label designs
for Shipping, Retail and Asset/Inventory. Profiles are configured with sample labels that

are appropriate for the application.

| Configure Workstation

workstation for a particular application

" Continue using the current settings
" Launch Setup Wizard

@ Load a pre-configured workstation profile

Description

Assets / Inventory and envelopes.

Continue using the current workstation settings or select a profile to automatically configure this

Retail Print shipping labels, return address labels

[~ {Show at starfup: Next

Label Group:|Shipping Label -]
DPING
Envelope
Mailing Label
Neaw [Retumn Address Label

If a profile is not chosen at start-up, all off the label groups will be available:
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Label Groups
Shipping Label
Envelope

lMailing Label

Return Address Label
Product Label

Round Product Label
Inwentory Label
Azzet Tag

Metwork PC Label

The sample groups can be used as is or modified to meet any custom criteria. To modify
a label group go to Configure Jolly Server Settings from the Admin Menu or from the
Setup button. Click on the Label Group and click Edit. There is also a shortcut to the
Label Group Properties dialog below the label rendering.

5 Main Location - Label Flow - Card Issue Cente o = o
File, Help
Configure Jolly Server Settings...
Configure Warkstation Options... =] Propertes Play Video
New Entry

Mr_Timethy Blaylock

acme Co

1500 Post Street, Sute 200
SanFranclsco, CA 841231000

ATME

San Canloe, CA 347
e

Find Record e 720455
aue wpenccs  [saces
<<Quantity>> | Swwe | <<Sanders>
i
DLW | s oace-
Report Center {01) 00000007 204555 = eight (1) =

IR

Print

Record Center ‘

Setup

)
JoLLY flow

Each Label Group has an associated label design. To edit the label design, open the Label
Group Properties, select the Label Printing tab and click Edit.
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After design modifications are finished click Exit and Save, click OK on the Label Group
Properties dialog.

Once completed, add new records by clicking the New Records button and see records
by clicking the Record Center button. There are a few sample records in each database.
Sample records may be deleted, but it is suggested a new record be added first so that

the data set is not empty.

Modifications to record look up and logs and reports are configured and the Label Group
Properties dialog shown above and will be explained in the Label Flow Print Center
section below.
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Using Label Flow

Label Flow is designed to simplify day-to-day data entry and the production of labels. It
allows the user to create new records, lookup an existing record and view reports of all
actions that have occurred. The Record Center shows all database records and their
label design.

Label Group:|mailing Label -

Acme Technologies
1000 Main Street
New Record Anytown, CA10000-1000
- Deliver to
Find Record IMr. Timothy Blaylock
Acme Co
1500 Post Street
Suite 200
San Francisco, CA 94123-1000
Report Center Ishalubo bl lun bl halhullial
Edit Label Group
Record Center |
2 Main Location - Label Flow - Label Print Center (==
File Admin Help
Record Center
Records for 'Shipping Label' are available below. Main Menu
Edit Delets Print ‘vl Torz ||| w4 J I E%

hy Blaylock

iy
Salutation Wr.

1500 Post Street, Suite 200
San Francisce, CA 941231000

ct s
WADE UL
Firstliame Timothy

Lastlame Blaylock

Streetagdress 1500 Post Streat

Streetadd uite 200
City San Francisce

State CA

PostalCode 54123-1000

Country
Companylame Acme Co
PhoneNumber 415-555-1212

Emailiddress tim.blaylock@acme.com

Accountumber 720455

To configure, select the Setup button on the Main Menu screen or from the Admin
Menu. Only Administrators have setup ability.
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Jolly Server Settings and Workstation Options

Label Flow is designed to run across multiple locations in a networked environment.
Shared settings such as label groups and log data are stored on the Jolly Server while
workstation specific options are configured in Workstation Options and Devices.

If Label Flow will be used in a standalone environment where it does not need to share
data with other workstations, it can use the Internal Jolly Server, installed as part of
Label Flow.

Installing Jolly Server

Jolly Server is installed separately from Label Flow. To install, run the Jolly Server
installer that was provided to you when you purchased the software on the target
server or workstation.

Connecting to a shared Jolly Server — Networking Multiple Copies

When networking multiple copies of Label Flow, install the Jolly Server on a central
server or shared workstation. All networked copies should point to the same Jolly
Server.

To connect to a Jolly Server, select File > Connect to Jolly Server.

Jolly Server

Program data is stored in the Jolly Server. A standalone version is installed with the
software. You may connect to the full version ofthe Jolly Server, installed separately, for
enterprise level data sharing and reliability. The full version is strongly recommended for
sites with high-volume traffic or multiple installations.

Connect to: |Internal [defaulf]

[v Show at startup Ok ‘ Cancel | Help ‘

By default, the Internal Jolly Server is selected. When Internal Jolly Server is selected,
the software will operate in standalone mode.

To connect to a shared Jolly Server, click the Configure button.
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Jolly Server Connection Settil E

|| Program data is stored in the Jolly Server. Configure the connection to the Jolly Server below.

" Use Internal Jolly Server [default]

Stare data in the local Jolly Server database installed with the software. Select this option if
you do not need to share program data with other workstations.

* Connect to Jolly Server

Connectto an external Jolly Server installation (installed separately). Select this option if
you intend to share data between workstations and for enterprise level performance and

reliability.
Connection Type: |Slandard Jolly Server Connection j
Server Address |JU||ySer\fe[

Examples: server.domain.com, 192.168.1.1

Set Login | Password

Cancel | Help |

Enter the name of the server or workstation where Jolly Server was installed.

Jolly Server Settings

Jolly Server Settings are settings that can be shared between workstations such as Label
Groups, Locations, Logs and Reports, Security Policy and User Accounts.

Category Label Groups
Each Iabsl group represents a logical group of labels and includes a label design, labsl
Locations. database, program and reporting options.
Logs And Reports
Security Policy
E-mail
User Accounts Label Groups | [ Preview

Shipping Label
Envelope

Mailing Label

Return Address Label
Product Label

Round Product Label
Inventory Labsl
Asset Tag

Network PC Label

Hew ‘ Edtt | Delete |

Close Hel|
" I

Settings for Locations, Logs and Reports Security Policy and User Accounts are obvious
when the dialog is open.

To configure the label group’s settings, highlight the group and select edit.
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Workstation Options and Devices

Workstation Options and Devices apply to a specific workstation. They include selecting
the location, label groups available at this location, selecting which tasks will be
available to the user, configuring the task options, and selecting the language to be used
a this location. Tasks are configured individually through the task’s blue hyperlink or
together via the configure button.

Wiorkstation Settings =
Location

Select the locaton where this workstation resides.

VHOESEalon Locatan Man Location | =]
Label Groups

Select the sbel groups that can be used at this workstation.

[ tates =

F

Tasks

Select the tasks o perform at this werkstaton. To configure 8 task simply Canfigure
cickeon b

F Mon e I Logs Arg Reports

P Hawk 7 P

W Fined Aecq W Bogged Conte

Select the defaut taskc Main Leny -
Language

Restart the apcbcation Afier changing the Mnguage selection

[engin -

¥ Show selection dialog at startup

Load Profie | s:ureweniu.s] | oK | Cancel | Het ]

Enable Label Groups by checking the boxes in the Label Groups dialog. It is important to
enable new Label Groups after they have been created. They will not show up
automatically.

Workstation Profiles may be named and saved for different types of use or for
deployment across a wide-range of workstations.

Important Note: Before changing profiles, it is important to save the changes made to
the existing profile if changes want to me kept.
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Design Screen

The design screen contains four toolbars: general items, alignment tools, object
formatting and design objects:

|
(D@ v R X0 B0 @ shoulye [ Lwdas ]

- 7 h|
(menm pslmdod -+ 47+ - R T 8 |Joe B Nin i [ o] |
:ng-m = W% =] [ [ —rjuﬂ-?pu-J
R
o General Items Object Formatting
—\ Alignment Tools
] ;
‘&-._i Design {}t‘{il.‘ﬂ'ﬁ R| Pointer T Insert Text
e 4, Zoom A Instert Image
g l Insert Line B Insert 1D barcode
1 O Insert Rectangle Bl Insert 2D barcode
) InsertEllipse J1) Encode RFID tag
IR
.}}})
—

Labels are designed by selecting the design object on the left-hand toolbar and by
drawing that object’s area on the label with the mouse. After the area drawn the
object’s Properties dialog will appear. Click through the tabs to format the object.
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| File Edit Add View Tools Window Help

[=] Ales [ Showleyers [ Live
] w in

v in h in inches hd

=
Pl

FROM DELVER TO

ACME <<3alutation>> <<FirstName>> <<LastName>>

195 Glenn Way << P

San Carlos, CA 94070 (Siom[:::zNam:» 3 tAdd 255

MADE IN USA << Free ress1>>, <<Stree ress
<<City>> <<State>> <<PostalCode>>

i << AccountNumber>>

R3e[dl L ~13

. uufgauantityb S:ngrclﬂi?)me S2E<ERSender1>>
MFG DATE
: AN | 2 <vrpate->

NET WT

(01 ) 00000000000000 <<NetWt>>

Pt ]
[
)))) | ﬁ% {;
4
20 Barcode Properties: Data Matrix ECC200 =3
|| I I|I| || || | I Data __B_ﬁrccde_ype Barcode E"DFE”iﬂ] EE‘”] Dimensions | Print Condition

Symbology

Data Matrix is a tw matrix g gy C of
black and white sguare modules arranged in either a square or
rectangular pattern. The symbol utiizes Reed-Selomen error
correction to ensure data reliability.

Prefix: None -

Ok | Cancel ‘ Apply | Help |

Objects may be resized at any time and Properties dialog re-accessed by double-click.

Working with Text

Label Flow contains rich text editing. Regular text, database text, serial number, date
and time may be combined within one text box. Type with a keyboard or use the + Field
button for text selections:
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[i50z] | ..' [# 0 =] [oial ] 11 =] [— =] [oo7ret ~
[k | [ 1 | 2 3 4 5
L i . \ . | . . . i . . . | . . . ) |
q 0
N\ Test =)
™ 1 Tent| Fropetties| Border| Dimensions | Frin Conciion |
—1 777777777777777777777777777777777777777777777777777 BsuUu|=E==|~=_ N arial v [+
O ] H BRI NET e << asthame>>
|T Dept: <<Department>>
1T
—al il Edit |+Tn inclide datahase field_d=te time etc. click on '+ Field
)
| Serial Number
¥ Date...
Time...
1 Data Entered at Print-Time... :l Foreel e
haaasss)
Symbol...
28 Tab

There are three types of text formatting: Text Box, Flexible Text and Circular Text. Text
Box will always place text within the bounds of the box drawn in the design: If larger, it
will auto-reduce in font size or word wrap. Flexible Text will maintain font size
regardless of the size of the box drawn. Circular Text formats text in a circle.

I Text Field ==

Text Ernpe't\BSI Border| Dimensions | Print Condtion

Ship To / POE D<<Company_Name>> "
<<Address_Line_One>>

D OV “<Address_Line_Two>>

<<City>>, <<State>> <<Postal_Code>>

n o Style
Ultimate Consignee / Mark For Consignee Text Ditection I
Circular Text
E 1123423423872598273C Liwordwhep
1 ATTN: MIKE RUMS ¥ Auto Beducs Font Size

650-594-2329

ak Cancel Apply Help

Working with Layers

Like other quality graphical design tools, Label Flow uses a layered design approach.
Layers may contain different design objects of varying opacity. Using layers adds a rich
depth to designs.

To see the layers window click the Show Layers checkbox on the top menu bar. Layers
are added using the [+] button at the bottom of the window. Use the arrow buttons to
move layers above and below other layers. Click the Print checkbox on each layer to
format its print condition. The active design layer is highlighted blue.
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Layers of MIL-5TD-129P Labeljps E
Layers | Objects I

Opacity: | nox
Vizible Layer Preview Frirt
¥ |Layer2 % - [
¥ |Layeri % ]

2| X 2] 4]

Using conditional printing, different layers may be printed based on criteria in the
database. In the example below, a different label design may be printed specifically for
a specific customer.

1l Record Match Condition o2 =]
[Begin__[Left Value [Condition [Right Value [End [Combine

Database Field: Company et Walmart

Print Condition - [Layer 2] @

Cartains

 Always print this layer
" Do not print this layer

£+ Pririt thiz layer based on

[~ Print in black (K] panel Use SQL Expression [ Leave blank to match all records ] Clear Filter

Ok | Cancal | Hep | o | Cancel

Help ‘

Viewing Designs with Live Data

At anytime the label design may be viewed with data by checking the Live Data button
on the top menu bar:

"+ Label Fiow » [Shigging Label jpa]

(] Fle Edt dsd view Tesls Wimsew Help

OSd -~ thBx o B & R G|
i + 4 ifl e

II\IIIIIII\IIII\I
= 7678767644

|| i | L
N m
85 PIECES | ] ] ABS78676

I
I|IIIIIII|III|II|I|IIII|II|| Il | o772

(01) 15979841564564 | ¢ | Bs
To view the full record set: go to File -> Database Setup or click the data icon on the top
menu bar:

MM.‘\"S MEN'S $TORE
1134 POWELL STREET

SANCARLOS.CA | AN FRANCISCO, CA 93219

4070
MADE W USA
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File Edit Add View Tools Window Help

O eEeE «

Saving Design

O

Use File -> Exit to save the design and close the designer.

Find Record Configuration

Find Record allows the user to quickly search for records. When multiple matches occur
a selection dialog is shown. Strict matching may be invoked.

Find Record

Please enter the record ID and click Next.

ID Number

Daon't know your ID Number? Complete this form to look it up

LastName |
FirstName |

CompanyName |

{ AccountNumber (72045 )

*+ Main Location - Label Flow - Label Print Center

File Admin Help

Record Found
The following matching record was found.

Edit Print View Histary ‘

Salutation Mr.
Firstllame Timothy
Lastlame Blaylock
StreetAddress1 1500 Post Street
StreethddressZ Suite 200
City San Francisco
State CA
PostalCode 54123-1000

Country

Companylame Acme Co
PhoneNumber 415-555-1212
Emailaddrese  tim blaylock@acme.com

AccountNumber 720455

Clear Fields

Hir. Timothy Blayiock

Acme Co

1500 Post Street, Suite 200
§an Francisco, CA 34123-1000

$8N Canos. CA S4070
MADEINUSA

(01) 00000007204555

Edit Label Design
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To configure record lookup, first define the lookup fields in the Lookup Fields tab of

Label Group Properties dialog found in Global Settings, then, define additional options in
the Advanced Options.

| Label Graus Prapemer

Gorarsd  Wocordooiup | e b

Advanced Options @

Configure the advanced options for Record Lookup.

B ?\dask IC number input (characters will be replaced with * Symbol)§

[™ Use strict matching - all information fislds must be complete

[v Allove user to select from muttiple matches

v allove user to select from a list of recards

904 | Cancel ‘ Help ‘

Report Center Configuration

Logs and Reports shows activity on all actions that occur in the product: when a record
was added, edited or deleted and when label was printed; by whom, at what time and

location. Custom logs may be designed. Reports may be printed, exported and emailed.

Logs and Reports

Salect & log o repor bk

Four fields from a label’s record may be configured in the Logs and Reports tab on the

Label Group Properties dialog. The Workstation Setting for Logs and Reports makes the
item available or not.

Record Center
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Record Center is used for the management of records. Records may be added, edited,

deleted, printed and duplicated from this screen. The down-arrow button provides
additional options.

s Main Location - Label Flow - Label Print Center o & ==
File Admin Help

Record Center

Records for 'Return Address Label are available below. Main Menu

dew | pat | Delete et [[F] vl EEE e | HE__D%
| |

Records v
IDHumber 1 I H
R nologies
Firsthiame Timotny Viear All Record: Qtreet
LastName Blaylock Current Record 14 Duplicate Record
Companyliame 4cme Co Selected Records 3 View Log.. 0
Strestaddress! 1500 Post Street

EAR Label Design
Edit Record Layout
Strestaddress2 Suite 200

City San Francisee Edit Label Design.

State CA

Medify Database Source...

PostalCode $4123-1000

Country
Phonelumber 415-555-1212
EmaiAddress timblaylock@acme.com

Accountlumber 720455

Records may be viewed in single-record or spreadsheet view by selecting the buttons on
the right of the toolbar.

7 Main Location - Label Flow - Label Print Center ===
File Admin  Help

Record Center

Records for 'Return Address Label' are available below. Main Menu

bew | Bt | pee Print |v” 1= || EDEIET A |f"'“ =l ==
S ;

[T # IDNumber Salutaton FirstName LastMame C 1 Streetadd: City State PostaiCode Country

I . Timothy ~ Blaylock Acme Co 1500 Post Street Suite 200 San Francisco CA  94123-100C 415-555-1212tim blaylock@acme.com 720455
Mz 2 Is. Tina Franders Apex, nc 1200 Sth Avenue Hew York WY 124452001 USA 2125551212 tina.franders@apex.com 149738
O3 3 ur. John Blaylock Acme Co 1500 Post Street Suite 200 San Francisco CA  §4123-100( 41 212 tim.blaylock@acme.com 720455
Mg o« s, Francie  Blaylock Acme Co 1500 Post Street Suite 200 SanFrancisco A 94123-100C 4155551212 tim.blaylock@acme.com 720455

Records may be batch printed, deleted and edited by checking the box to the left of the
record and selecting the appropriate action. Records may be sorted by clicking on
column headers.

The toolbar contains filter and sort buttons i . Filters are used to create data
subsets. Sorting allows for multiple field sort criteria.

13 i rnconae s )
Configurs a recond filler 1o show anly récords that mest the specifiad criteia. To show all récords,
chck Claar Filter. Record filters may also ba stored for flee use
[Eombing Sort Setup...

[Begin_[Lefivae  [Condition |Right Vialug End
| | ¥ Sort Records by Follawing Fields

Ciotatase Feid DmeQTENt  Aner Tead 1L

Sorton Field [soring Dider | Combine
FirstMame Ascending AND
LastHame || &scending END

IDMNumber
Firsthlame

Lss S0 Evpression [ Leve blarik 1o mal

<h all racords] Claar Fiter Tile
Load Fiter | Store Filler As Ok Cancel Help R:F:#’rgm | | Cancel Help
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Configuring the Record Screen

Label Flow has drag-and-drop record screen formatting. Select Edit Record Layout from
the down-arrow menu on the Record Screen: Size and move fields with the mouse.
Caption placement, colors and alignment tools are provided on the menu bar.

Fia Edl Layod
ek [Comparntiame =] W v I Rowd-ory I Reqared Fiekd
Rt [Company Name - b =] [rve | oot W [ricrmet =
Format. [Tact =] [Herm
Smven Formatind Daln Datwlt Vo [ 3
) 1 ]
Sal. | FirstName LastHame |
— _| A P e, e o —
Company Name
|
Street Address T & B
Street Address 2
City | | State | PostalCode
Country
Phone Number E-mail Address

Advanced Field Formatting

Label Flow Premier Edition contains advanced field formatting. Fields may be made
Visible, Required and Read Only. They may be given default values. Drop-down lists
may be created. Text can be set to Capitalize, UPPER CASE or lower case. Image paths

may be created to store variable images to file. Fields can automatically update after a
label is printed.

:] Customize Layout

Edit  Layout
Field: | pateo Birth | W Visible [~ Read-only [~ Required Field
Caption: |Date of Birth |—J |Buld j |Abuve j Data: -_ Mormal A
Format |pate and Time  +| [ Date: 7120009 v I Time: 05:39:16 PM

" Save Formatted Data Default Value: -

100 I

Configuring Language
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Label Flow is available in 10+ languages. Select the language in the Workstation
Settings. A translation table allows the user to make changes to the translation or to
translate into a language not yet provided by Jolly. After changing languages, restart the
program.

Q Translation Text == )

File Find

Enter translated text in the right-hand column. Special tags must be entered exactly
as in the English version.

<«|joa 5|

English Norwegian
2053( Sorting Order Sortering Bestill
2054| Source &Table: &Source Tabell:
2055| Source file: <<none selected== Kilde: =<ingen adresse valgt=»>
2056 Spacing Avstand
2057 | Spanish Spansk
2058| Specia&l Conditions. &Spesiele betingelser:
2059( Special Charactegr... &Special Character ...
2050( Specific Date Bestemt dato

ST Specify a title for the data block and how | Angi en tittel for data blokk og hvor ofte blir
often the user iz prompted for a new piece |brukeren bedt om en ny brikke av data

Specify a title for the image and how often | Angi en tittel for bildet og hvor ofte biir

2062 the user is prompted for a new image while | brukeren bedt om et nytt bilde under utskrift.

2063 | Specify Criteria Angi Kriterier

2064 Specify Criteria (CTRL + F) Angi kriterier (CTRL + F)

2085 Specify Page And Press Enter Angi siden og trykk ENTER J

2086 Specify rotation angle for the text Angi rotasjon vinkel til teksten

2067 | Specify SQL &Expression &Spesifiser SQL-uttrykk

s068 Specify the text to search and press Angi teksten du vil seke og trykk <ENTER= & -
ENTFR in atart =earch atarte soket

Import Export Save Cancel Help

The information contained in this document represents the current view of Jolly Technologies on the issues discussed as of the date
of this publication. This paper is for informational purposes only. Jolly Technologies makes no warranties, express or implied in this
document. Jolly, Jolly Technologies, Label Flow, Lobby Track, and Command Line Utility are either trademarks or registered
trademarks of Jolly, Inc. in the United States of America and/or other countries. The names of actual companies and products
mentioned herein may be the trademarks of their respective owners.
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